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Chapter 513

Superiority by a Margin
Tests for the Ratio of
Two Means in a 2x2
Cross-Over Design
(Log-Normal Data)
Introduction
This procedure calculates power and sample size of statistical tests for non-unity null tests from a 2x2 cross-over
design. This routine deals with the case in which the statistical hypotheses are expressed in terms mean ratios rather
than mean differences.
The details of testing the non-unity null of two treatments using data from a 2x2 cross-over design are given in
another chapter and they will not be repeated here. If the logarithms of the responses can be assumed to follow the
normal distribution, hypotheses about non-unity null hypotheses stated in terms of the ratio can be transformed into
hypotheses about the difference. The details of this analysis are given in Julious (2004). They will only be
summarized here.

Superiority Testing Using Ratios
It will be convenient to adopt the following specialized notation for the discussion of these tests.
Parameter
𝜇𝜇𝑇𝑇

PASS Input/Output Interpretation
Not used
Treatment mean. This is the treatment mean.
Not used

Reference mean. This is the mean of a reference population.

𝑀𝑀𝑆𝑆

SM

Margin of superiority. This is a tolerance value that defines the
magnitude of difference that is required for practical importance. This
may be thought of as the smallest difference from the reference that is
considered to be practically significant.

𝜙𝜙

R1

Actual ratio. This is the value of 𝜙𝜙 = 𝜇𝜇𝑇𝑇 /𝜇𝜇𝑅𝑅 at which the power is
calculated.

𝜇𝜇𝑅𝑅
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Note that the actual values of 𝜇𝜇𝑇𝑇 and 𝜇𝜇𝑅𝑅 are not needed. Only the ratio of these values is needed for power and
sample size calculations.

When higher means are better, the hypotheses are arranged so that rejecting the null hypothesis implies that the
ratio of the treatment mean to the reference mean is greater than one by at least the margin of superiority. The
value of 𝜙𝜙 at which power is calculated must be greater than 𝜙𝜙0 = 1 + |𝑀𝑀𝑆𝑆 |.

𝐻𝐻0 : 𝜙𝜙 ≤ 1 + |𝑀𝑀𝑆𝑆 |

versus

𝐻𝐻0 : 𝜙𝜙 ≤ 𝜙𝜙0

versus

𝐻𝐻0 : 𝜙𝜙 ≥ 1 − |𝑀𝑀𝑆𝑆 |

versus

𝐻𝐻1 : 𝜙𝜙 > 1 + |𝑀𝑀𝑆𝑆 |
𝐻𝐻1 : 𝜙𝜙 > 𝜙𝜙0

When higher means are worse, the hypotheses are arranged so that rejecting the null hypothesis implies that the
ratio of the treatment mean to the reference mean is less than one by at least the margin of superiority. The value
of 𝜙𝜙 at which power is calculated must be less than 𝜙𝜙0 = 1 − |𝑀𝑀𝑆𝑆 |.

𝐻𝐻0 : 𝜙𝜙 ≥ 𝜙𝜙0

versus

Log Transformation

𝐻𝐻1 : 𝜙𝜙 < 1 − |𝑀𝑀𝑆𝑆 |
𝐻𝐻1 : 𝜙𝜙 < 𝜙𝜙0

In many cases, hypotheses stated in terms of ratios are more convenient than hypotheses stated in terms of
differences. This is because ratios can be interpreted as scale-less percentages, but differences must be interpreted
as actual amounts in their original scale. Hence, it has become a common practice to take the following steps in
hypothesis testing.
1. State the statistical hypotheses in terms of ratios.
2. Transform these into hypotheses about differences by taking logarithms.
3. Analyze the logged data—that is, do the analysis in terms of the difference.
4. Draw the conclusion in terms of the ratio.
The details of step 2 for the null hypothesis when higher means are better are as follows:
𝜇𝜇𝑇𝑇
≤ 𝜙𝜙0 ⇒ 𝐻𝐻0 : ln(𝜇𝜇𝑇𝑇 ) − ln(𝜇𝜇𝑅𝑅 ) ≤ ln(𝜙𝜙0 )
𝐻𝐻0 : 𝜙𝜙 ≤ 𝜙𝜙0 ⇒ 𝐻𝐻0 :
𝜇𝜇𝑅𝑅

Thus, a hypothesis about the ratio of the means on the original scale can be translated into a hypothesis about the
difference of two means on the logged scale.

Coefficient of Variation
The coefficient of variation (COV) is the ratio of the standard deviation to the mean. This parameter is used to
represent the variation in the data because of a unique relationship that it has in the case of log-normal data.
Suppose the variable X is the logarithm of the original variable Y. That is, X = ln(Y) and Y = exp(X). Label the
mean and variance of X as 𝜇𝜇𝑋𝑋 and 𝜎𝜎𝑋𝑋2 , respectively. Similarly, label the mean and variance of Y as 𝜇𝜇𝑌𝑌 and 𝜎𝜎𝑌𝑌2 ,
respectively. If X is normally distributed, then Y is log-normally distributed. Julious (2004) presents the following
well-known relationships between these two variables
𝜇𝜇𝑌𝑌 =

𝜎𝜎 2
𝜇𝜇𝑋𝑋 + 𝑋𝑋
2
𝑒𝑒

2

𝜎𝜎𝑌𝑌2 = 𝜇𝜇𝑌𝑌2 �𝑒𝑒 𝜎𝜎𝑋𝑋 − 1�
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From this relationship, the coefficient of variation of Y can be found to be
𝐶𝐶𝐶𝐶𝐶𝐶𝑌𝑌 =

2

�𝜇𝜇𝑌𝑌2 �𝑒𝑒 𝜎𝜎𝑋𝑋 − 1�
𝜇𝜇𝑌𝑌

= �𝑒𝑒 𝜎𝜎𝑋𝑋 − 1
2

= �𝑒𝑒 𝜎𝜎𝑊𝑊 − 1
2

2
where 𝜎𝜎𝑊𝑊
is the within mean square error from the analysis of variance of the logged data. Solving this
relationship for 𝜎𝜎𝑋𝑋2 , the standard deviation of X can be stated in terms of the coefficient of variation of Y as

Similarly, the mean of X is

𝜎𝜎𝑋𝑋 = �ln(𝐶𝐶𝐶𝐶𝐶𝐶𝑌𝑌2 + 1)

𝜇𝜇𝑋𝑋 = ln �

𝜇𝜇𝑌𝑌

�𝐶𝐶𝐶𝐶𝐶𝐶𝑌𝑌2 + 1

�

Thus, the hypotheses can be stated in the original (Y) scale and then power can be analyzed in the transformed
(X) scale.

Power Calculation
As is shown above, the hypotheses can be stated in the original (Y) scale using ratios or the logged (X) scale
using differences. Either way, the power and sample size calculations are made using the formulas for testing the
equivalence of the difference in two means. These formulas are presented in another chapter and are not
duplicated here.

Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains the parameters associated with this test such as the means, sample sizes, alpha, and
power.

Solve For
Solve For
This option specifies the parameter to be solved for from the other parameters. Under most situations, you will
select either Power for a power analysis or Sample Size for sample size determination.
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Test
Higher Means Are
This option defines whether higher values of the response variable are to be considered better or worse.
The choice here determines the direction of the test.
If Higher Means Are Better the null hypothesis is H0: R ≤ 1+SM and the alternative hypothesis is H1: R > 1+SM.
If Higher Means Are Worse the null hypothesis is H0: R ≥ 1-SM and the alternative hypothesis is H1: R < 1-SM.

Power and Alpha
Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis,
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null
hypothesis is not rejected. In this procedure, a type-II error occurs when you fail to reject the null hypothesis of
non-superiority when in fact the treatment mean is superior.
Values must be between zero and one. Historically, the value of 0.20 was often used for beta. Recently, the
standard has shifted to 0.10.
Power is defined as one minus beta. Power is equal to the probability of rejecting a false null hypothesis. Hence,
specifying the beta error level also specifies the power level. For example, if you specify beta values of 0.05, 0.10,
and 0.20, you are specifying the corresponding power values of 0.95, 0.90, and 0.80, respectively.
Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true
null hypothesis is rejected. In this procedure, a type-I error occurs when rejecting the null hypothesis of nonsuperiority when in fact the treatment group is not superior to the reference group.
Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that
about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents
the risk of a type-I error you are willing to take in your experimental situation.
You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

Sample Size
N (Total Sample Size)
This option specifies one or more values of the sample size, the number of individuals in the study (total subjects
in both sequences). This value must be an integer greater than one.
When N is even, it is split evenly between the two sequences. When N is odd, the first sequence has one more
subject than the second sequence.
Note that you may enter a list of values using the syntax 50,100,150,200,250 or 50 to 250 by 50.

Effect Size – Ratios
SM (Superiority Margin)
This is the magnitude of the margin of superiority. It must be entered as a positive number.
When higher means are better, this value is the distance above one that is required for the mean ratio (Treatment
Mean / Reference Mean) to be considered superior. When higher means are worse, this value is the distance
below one that is required for the mean ratio (Treatment Mean / Reference Mean) to be considered superior.
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R1 (Actual Ratio)
This is the value of the ratio of the two means (Treatment Mean / Reference Mean) at which the power is to be
calculated.
When higher means are better, this value should be greater than 1+SM. When higher means are worse, this value
should be less than 1-SM.

Effect Size – Coefficient of Variation
COV (Coefficient of Variation)
The coefficient of variation is the ratio of the standard deviation and the mean (SD/Mean). It is used to specify the
variability (standard deviation). Note that this COV is defined on the original (not logarithmic) scale. This value
must be determined from past experience or from a pilot study.
To be clear, consider the following definition. Suppose data on a response variable Y are collected. This
procedure assumes that the values of X = Ln(Y) are analyzed using an appropriate ANOVA procedure. Thus,
there are two sets of means and standard deviations: those of X labelled MX and SX and those of Y labelled MY
and SY. The COV entered here is the COV of Y = SY/MY. For log-normal data, the following relationship exists:
COV(Y) = SQR(Exp(SX*SX)-1) where SX is the square root of the within mean square error in the ANOVA
table of the log-transformed values.
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Example 1 – Finding Power
A company has developed a generic drug for treating rheumatism and wants to show that it is superior to the
standard drug by a certain amount. A 2x2 cross-over design will be used to test the superiority of the treatment
drug to the reference drug.
Researchers have decided to set the margin of superiority to 0.20. Past experience leads the researchers to set the
COV to 1.50. The significance level is 0.05. The power will be computed assuming that the true ratio is 1.40.
Sample sizes between 50 and 550 will be included in the analysis.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the procedure window. You may then make the appropriate entries as listed below, or open
Example 1 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Power
Higher Means Are ................................... Better (H1: R > 1 + SM)
Alpha ....................................................... 0.05
N (Total Sample Size)............................. 50 to 550 by 100
SM (Superiority Margin) .......................... 0.2
R1 (Actual Ratio) .................................... 1.4
COV (Coefficient of Variation) ................ 1.5

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for a T-Test ────────────────────────────────────────────────────
R = Treatment Mean / Reference Mean
Higher Means are Better
Hypotheses: H0: R ≤ 1 + SM vs. H1: R > 1 + SM

Power
0.17236
0.33694
0.47540
0.59088
0.68501
0.76017

N
50
150
250
350
450
550

Superiority
Margin
SM
0.200
0.200
0.200
0.200
0.200
0.200

Superiority
Bound
R0
1.200
1.200
1.200
1.200
1.200
1.200

Actual
Ratio
R1
1.400
1.400
1.400
1.400
1.400
1.400

COV
1.500
1.500
1.500
1.500
1.500
1.500

Alpha
0.050
0.050
0.050
0.050
0.050
0.050

Beta
0.82764
0.66306
0.52460
0.40912
0.31499
0.23983

Report Definitions
Power is the probability of rejecting H0 when it is false.
N is the total sample size drawn from all sequences. The sample is divided equally among sequences.
SM is the magnitude of the margin of superiority. Since higher means are better, this value is positive and is
the distance above one that is required to be considered superior.
R0 is the corresponding superiority margin bound and equals 1 + SM.
R1 is the mean ratio (treatment/reference) at which the power is computed.
COV is the coefficient of variation on the original scale.
Alpha is the probability of falsely rejecting H0.
Beta is the probability of not rejecting H0 when it is false.
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Summary Statements ─────────────────────────────────────────────────────────
A total sample size of 50 achieves 17% power to detect superiority using a one-sided t-test
when the margin of superiority is 0.200, the actual mean ratio is 1.400, the significance level
is 0.050, and the coefficient of variation on the original, unlogged scale is 1.5. A 2x2
cross-over design with an equal number in each sequence is used.

This report shows the power for the indicated scenarios. Note that if they want 80% power, they will require a
sample of more than 450 subjects.

Plot Section

This plot shows the power versus the sample size.

513-7
© NCSS, LLC. All Rights Reserved.

PASS Sample Size Software

NCSS.com

Superiority by a Margin Tests for the Ratio of Two Means in a 2x2 Cross-Over Design (Log-Normal Data)

Example 2 – Validation
This procedure uses the same mechanics as the Non-Inferiority Tests for the Ratio of Two Means in a 2x2 CrossOver Design (Log-Normal Data) procedure. We refer the user to Example 2 of Chapter 515 for the validation.
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